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CHAPTER 2. FLAT PLATE BOUNDARY LAYER

CHAPTER 2. FLAT PLATE BOUNDARY LAYER

A. Objectives

Creating the SOLIDWORKS part needed for the Flow Simulation
Setting up Flow Simulation projects for internal flow

Setting up a two-dimensional flow condition

Initializing the mesh

Selecting boundary conditions

Inserting global goals, point goals and equation goals for the calculations
Running the calculations

Using Cut Plots to visualize the resulting flow field

Use of XY Plots for velocity profiles, boundary layer thickness, displacement thickness,
momentum thickness and friction coefficients

Use of Excel templates for XY Plots

Comparison of Flow Simulation results with theories and empirical data
Cloning of the project

B. Problem Description

In this chapter, we will use SOLIDWORKS Flow Simulation to study the two-dimensional laminar
and turbulent flow on a flat plate and compare with the theoretical Blasius boundary layer solution and
empirical results. The inlet velocity for the 1 m long plate is 5 m/s and we will be using air as the fluid
for laminar calculations and water to get a higher Reynolds number for turbulent boundary layer
calculations. We will determine the velocity profiles and plot the profiles using the well-known
boundary layer similarity coordinate. The variation of boundary-layer thickness, displacement
thickness, momentum thickness and the local friction coefficient will also be determined. We will start
by creating the part needed for this simulation, see figure 2.0.

Ideal walls

Inlet section . -
: Lines for velocity profiles _
Outlet section

Real wall

Figure 2.0 SOLIDWORKS model for flat plate boundary layer study
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CHAPTER 2. FLAT PLATE BOUNDARY LAYER

C. Creating the SOLIDWORKS Part

1. Start by creating a new part in SOLIDWORKS: select File>>New and click on the OK button in
the New SOLIDWORKS Document window. Click on Front Plane in the FeatureManager
design tree and select Front from the View Orientation drop down menu in the graphics
window.

— I

G B & | &

¥

@ 7 Partl (Default<<Default>_Displa

History
Sensors

» [A] Annotations ﬁjv#v@ﬁvgv

EE Material <not specified> W @ =

bl 9-

[j_-] Top Plane —
[1] Right Plane G
L, origin Front (Ctrl+1)

Figure 2.1a) Selection of front plane Figure 2.1b) Selection of front view

2. Click on the Sketch tab and select Corner Rectangle.

? . .
_] DS SOLIDWORKS |  File Edit.
cC & /-G-WN-
Sketch  Smart
= Dimr::sinn D -| % - @ =y
= - [ Corner Rectangle

Features | Sketch [ E Center Rectangle

Figure 2.2 Selecting a sketch tool

3. Make sure that you have MMGS (millimeter, gram, second) chosen as your unit system. You can
check this by selecting Tools>>Options from the SOLIDWORKS menu and selecting the
Document Properties tab followed by clicking on Units. Check the circle for MMGS and click
on the OK button to close the window. Click to the left and below the origin in the graphics
window and drag the rectangle to the right and upward. Fill in the parameters for the rectangle,

'

see Figure 2.3a). Close the Rectangle dialog box by clicking on . Right click in the graphics

window and select Zoom/Pan/Rotate>>%" Zoom to Fit.
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Parameters .
o, -100.00 :
s, 0.00 :
o, -100.00 :
s, 100.00 :
o 1000.00 :
°, 100.00 :
o 1000.00 :
*, 0.00 :

Figure 2.3a) Parameter settings for the rectangle

Zoom/Pan/Rotate k | ||ﬁ Zoom to Fit

Figure 2.3b) Zooming in the graphics window

Repeat steps 2 and 3 but create a larger rectangle outside of the first rectangle. Dimensions are
shown in figure 2.4.

Parameters L)
L -120.00 :
®y -20.00 :
L -120.00 :
®y 120.00 :
o 1020.00 :
°, 120.00 :
i 1020.00 :
e -20.00 :

Figure 2.4 Dimensions of second larger rectangle



CHAPTER 2. FLAT PLATE BOUNDARY LAYER

5. Select Features tab and Extruded Boss/Base. Check the box for [¥] Direction 2 and click

OK to exit the Boss-Extrude Property Manager.

? = =
JpS SOLIDWORKS | File Edit V

ﬁ @ & Swept Boss/Base

Extruded | Revolved Lofted Boss/Base
Boss/Base | Boss/Base

@ Boundary Boss/Base

Figure 2.5a) Selection of extrusion feature

? .
JpS SOLIDWORKS| File Ed

Features | Sketch | Markup | Evaluate

G B4 | S
@] Boss-Extrude1 @
v | X W

Figure 2.5b) Closing the property manager

6. Select Front from the View Orientation drop down menu in the graphics window. Click on
Front Plane in the FeatureManager design tree. Click on the Sketch tab and select the Line
sketch tool.

JpS SOLIDWORKS| File Edit View

cC & G-wn-#

Sketch Smart .
Dimension n/: Line

A i
:r** Centerline

- -

Features | Sketch [ \ Midpoint Line

Figure 2.6 Selection of the line sketch tool
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7. Draw a vertical line in the positive Y-direction in the front plane starting at the lower inner
surface of the sketch. Set the Parameters and Additional Parameters to the values shown in
o

figure 2.7. Close the Line Properties dialog and the Insert Line dialog.

Parameters L

& 2000 k=
|l“ 90.00°

*

1 ¥

Additional Parameters Ea

200.00

4% 4 )

0.00

200,00

4k 4 p

20.00

NN NN

0.00

LI

AY 2000 e

-

Figure 2.7 Parameters for vertical line

Repeat steps 6 and 7 three more times and add three more vertical lines to the sketch, the second

line at X = 400 mm with a length of 40 mm, the third line at X = 600 mm with a length of 60 mm

and the fourth line at X = 800 mm with a length of 80 mm. These lines will be used to plot the

boundary layer velocity profiles at different streamwise positions along the flat plate. Close the

Line Properties dialog L4 and the Insert Line dialog. Save the SOLIDWORKS part with the
following name: Flat Plate Boundary Layer Study 2021. Rename the newly created sketch in
the FeatureManager design tree, see figure 2.8. You will need to left click twice to rename the

sketch.

% 'ﬂ' Flat Plate Boundary Layer Study 2020
’ History
Sensors
L4 Annotations
v [m] Solid Bodies(1)
EE Material <not specified>
m Front Plane

[ﬂ Top Plane
[1] Right Plane

L, Origin
4 @ Boss-Extrude]
[ (9x=02040608m
Figure 2.8 Renaming the sketch for boundary layer velocity profiles
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9. Click on the Rebuild symbol e in the SOLIDWORKS menu. Repeat step 6 and draw a
horizontal line in the X-direction starting at the origin of the lower inner surface of the sketch. Set
the Parameters and Additional Parameters to the values shown in figure 2.9 and close the Line
Properties dialog and the Insert Line dialog. Click on the Rebuild symbol. Rename the sketch
in the FeatureManager design tree and call it x =0 — 0.9 m.

Parameters Ea

£ 900.00 =
[& o000

1 ¥

Additional Parameters Ca

0.00

4°F 4 F
o |

0.00

900.00

4F 4

0.00
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NN N

900,00

El

o .

e

=

Figure 2.9 Sketch of a line in the X-direction

10. Next, we will create a split line. Repeat step 6 once again but this time select the Top Plane and
draw a line in the Z-direction through the origin of the lower inner surface of the sketch. It will
help to zoom in and rotate the view to complete this step. Set the Parameters and Additional
Parameters to the values shown in figure 2.10 and close the dialog. Click on the Rebuild
symbol.

Parameters

& 2000 =

»

N 90.00° -
Additional Parameters
/ 0.00 =
x -
/ 10,00 o
T -
/ 0.00 2
x -
/' 10.00 -
T -
-~
Ax 0.00 i
AY 20.00 -

-

Figure 2.10 Drawing of a line in the Z-direction
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11. Rename the new sketch in the FeatureManager design tree and call it Split Line. Select
Insert>>Curve>>Split Line... from the SOLIDWORKS menu. Select Projection under Type
to Split. Select Split Line for Sketch to Project under Selections. For Faces to Split, select the

L'

surface where you have drawn your split line, see figure 2.11b). Close the dialog . You have

now finished the part for the flat plate boundary layer. Select File>>Save from the
SOLIDWORKS menu.

Tools Window Help » | ﬁ- D -

Boss/Base »
Cut »

Features [
Pattern/Mirror [
Fastening Feature [
FeatureWorks [

Surface [

Face 3
| Curve [ | @ Split Line...
Figure 2.11a) Creating a split line

Features | Sketch | Evaluate | MEBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | SOLIDWORKS CAM TEM

G EB[®[S[T]
& spiit Line @
v X

Type of Split A
@) Silhouette

@) Projection

@) Intersection

Selections Cad

E Split Line

o
Single direction
|:| Reverse direction

Figure 2.11b) Selection of surface for the split line
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D. Setting Up the Flow Simulation Project

12. If Flow Simulation is not available in the menu, you have to add it from SOLIDWORKS menu:
Tools>>Add Ins... and check the corresponding SOLIDWORKS Flow Simulation 2021 box
under SOLIDWORKS Add-Ins and click OK to close the Add-Ins window. Select Tools>>Flow
Simulation>>Project>>Wizard to create a new Flow Simulation project. Enter Project name:
“Flat Plate Boundary Layer Study”. Click on the Next > button. Select the default SI (m-kg-s)
unit system and click on the Next> button once again.

Tools | Simulation Window M ﬁ' D - E? - ﬁ - g o T vI

- s @ Rib (&g Wrap °i
ANSYS 2020 R1 b t Linear Referer
Pattern E Draft l@ Intersect Geome
Floy [ Mew.. Project k
Ass|| % Wizard...
ﬁ ~ Insert »

Figure 2.12a) Starting a new Flow Simulation project

Wizard - Project Mame

Project

Project name: Flat Plate Boundary Lager Study

Comments:

Figur:e 2. i2b) Creating a name for the project

13. Use the default Internal Analysis type and click on the Next> button once again.

Wizard - Analysis Type ? X
Analyziz type Conzider clozed cavities @
(®) Intemal [+ Exclude cavities without flow conditions [l
() External Exclude internal space

Physical Features lue
Heat conduction in solids
Radiation
Time-dependent

Gravity

Rotation

Free surface

Figure 2.13 Exclusion of cavities without flow conditions

ooododes
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14. Select Air from the Gases and add it as Project Fluid. Select Laminar Only from the Flow
Type drop down menu. Click on the Next > button. Use the default Wall Conditions and click
on the Next > button. Insert 5 m/s for Velocity in X direction as Initial Conditions and click on
the Finish button. You will get a fluid volume recognition failure message. Answer Yes to this

question and create a lid on each side of the model. Answer Yes to the questions when you create
the lids.

Wizard - Default Fluid [4 X
Fluids Path ~ Mew... »
= Gases
‘g Pre-Defined
i Acetone Pre-Defined
Ammonia Pre-Defined
Argon Pre-Defined
Butane Pre-Defined
Carbon dioxide Pre-Defined
i~ Chloring Pre-Defined
i Ethane Pre-Defined
-~ Ethanol Pre-Defined v Add
Project Fluids Default Fluid Remaove
Air { Gases )

Flow Characteristic Value

Flow type Laminar Onky
& High Mach number flow [ ]
’ i 0

Figure 2.14 Selection of fluid for the project and flow type

15. Select Tools>>Flow Simulation>>Computational Domain.... Click on the 2D simulation
L

button under Type and select XY plane. Close the Computational Domain dialog

Tools | Simulation Window & ﬁ' B - E? - ﬁ - % - 5

- s @ Rib  [mg wrap
AMSYS 2020 R1 b [ Linear c
Pattern i}_‘] Draft ﬂ?l Inters:
Flow Simulation » Project

ﬁ‘ Asset Publisher...
Insert

General Settings...
B Defeature...
S+ Export To AEC...

AEC

}_.: Units...

@ Computational Domain...

Figure 2.15a) Modifying the computational domain

@ Computational Domain @
v X
Type ~

3D simulation
@ 2D simulation

@ XY plane

Figure 2.15b) Selecting 2D simulation in the XY plane
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16. Select Tools>>Flow Simulation>>Global Mesh.... Select Manual under Type. Change Nx to
300 and Ny to 200. Click on the OK button (green check mark) to exit the Initial Mesh window.

Tools | Simulation Window ﬁ' D - E? - ﬁ - g - £y

F

AMSYS 2020 R1

3 @Rib &d wrap

[ Linear
Pattern iﬁ Draft @ Interse

Flow Simulation

ﬁ Asszet Publisher...

B Defeature...

E Export To AEC...

Select

Figure 2.16a) Modifying the initial mesh

HH Global Mesh Settings )
v X
Type

Automatic
Manual

Basic Mesh
Nx 200 [=]

=
Ny 200 %

=,

Project
Insert

General Settings...
Units...

Computational Domain...

Global Mesh...

B0 F ®

Figure 2.16b) Changing the number of cells in two directions
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E. Selecting Boundary Conditions

17. Select the < Flow Simulation analysis tree tab, open the Input Data folder by clicking on
the plus sign next to it and right click on Boundary Conditions. Select Insert Boundary
Condition.... Select Wireframe as the Display Style. Right click in the graphics window and
select Zoom/Pan/Rotate>>Zoom to Fit. Once again, right click in the graphics window and
select Zoom/Pan/Rotate>>Rotate View. Click and drag the mouse so that the inner surface of
the left boundary is visible. Right click again and unselect Zoom/Pan/Rotate>>Rotate View.
Right click on the left inflow boundary surface and select Select Other. Select the Face
corresponding to the inflow boundary. Select Inlet Velocity in the Type portion of the Boundary
Condition window and set the velocity to 5 m/s in the Flow Parameters window. Click OK to

exit the window. Right click in the graphics window and select El Zoom to Area and select an
area around the left boundary.

£5: Flat Plate Boundary Layer Study
E% Input Data
------- @ Computational Domain

....... [ Fluid Subdomains Zoom/Pan/Rotate > | §2 ZoomtoFit
....... 'm Boundary Conditions ﬁ Zoom to Area
...... F Goals v OK

I Zoom In/Out
®  Cancel p

@B Results (Not loaded) @ Rotate View

Figure 2.17a) Inserting boundary condition  Figure 2.17b) Modifying the view

l|[%|$|0 el

Ef Inlet Velocity 1
v X

Selection La

m Face<l>

lg'x Face Coordinate System

Reference axis: Q
Type 2%

Eel~

Inlet Mass Flow -

Inlet Mass Flux
Inlet Vulume Flow B

]nlet Mal:h Numbel
Outlet Mass Flow
Cutlet Volume Flow &

Flow Parameters Lad

&[]
vV 5mis
Fully developed flow

Figure 2.17¢) Velocity boundary condition on the inflow
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Figure 2.17d) Inlet velocity boundary condition indicated by arrows

Red arrows pointing in the flow direction appear indicating the inlet velocity boundary condition,
see figure 2.17d). Right click in the graphics window and select Zoom to Fit. Right click again in
the graphics window and select Rotate View once again to rotate the part so that the inner right

surface is visible in the graphics window. Right click and click on &Select. Right click on

Eﬁ Boundary Conditions in the Flow Simulation analysis tree and select Insert Boundary
Condition.... Right click on the outflow boundary surface and select Select Other. Select the
Face corresponding to the outflow boundary. Click on the Pressure Openings

button in the Type portion of the Boundary Condition window and select Static Pressure. Click
OK to exit the window. If you zoom in on the outlet boundary, you will see blue arrows
indicating the static pressure boundary condition, see figure 2.18b).

Ef Boundary Condition @
v X

Selection £
@

.Z*x Face Coaordinate System

Reference axis: ‘,

Type 2

[ &~

Environment Pressure

101325 Pa

Static Pressure
Total Pressure

Thermodynamic Parameters ~
P 101325FPa
T 2932k

Goals w

Figure 2.18a) Selection of static pressure as boundary condition at the outlet of the flow region
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|
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Figure 2.18b) Outlet static pressure boundary condition

19. Enter the following boundary conditions: Ideal Wall for the lower and upper walls at the inflow
region, see figures 2.19. These will be adiabatic and frictionless walls.

i s

] Ideal Wall 1 @
v X
Selection ~
m Face<l>

Fate<2>

_g»x Global Coordinate System

Reference axis: [;]
Type ~

La[)

| Real Wall

Ideal Wall

Figure 2.19 Ideal wall boundary condition for two wall sections
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20. The last boundary condition will be in the form of a Real Wall. We will study the development
of the boundary layer on this wall.

I} Real Wall 1 @
v X

Selection ”~
m Face<l>

]
.g’x Face Coordinate System
Reference axis: 5'

Type £y

B
Real Wall |
Ideal Wall

Figure 2.20 Real wall boundary condition for the flat plate

F. Inserting Global Goals and Calculation Controls

21. Right click on Goals in the Flow Simulation analysis tree and select Insert Global Goals....

Select Friction Force (X) as a global goal. Exit the Global Goals window. Right click on Goals
X

in the Flow Simulation analysis tree and select Insert Point Goals.... Click on the *z| point
Coordinates button. Enter 0.2 m for X coordinate and 0.02 m for Y coordinate and click on the

Add Point button \i‘ Add three more points with the coordinates shown in figure 2.21e). Check
the Value box for Velocity (X). Exit the Point Goals window. Rename the goals as shown in
figure 2.21f). Right click on Goals in the Flow Simulation analysis tree and select Insert
Equation Goal.... Click on PG Velocity (X) at x = 0.2 m goal in the Flow Simulation analysis
tree, multiply by 0.2 (for x = 0.2 m) and divide by /.516E-5 (kinematic viscosity of air at room
temperature (v = 1.516E-5 m?%/s) to get an expression for the Reynolds number in the Equation
Goal window, see figure 2.21g). Select Dimensionless LMA from the dimensionality drop down
menu. Exit the Equation Goal window. Rename the equation goal to Reynolds number at x =
0.2 m. Insert three more equation goals corresponding to the Reynolds numbers at the three other
x locations. For a definition of the Reynolds number, see equation (2.15).
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EZ Flat Plate Boundary Layer Study

E@ Input Data
... ]] Computational Domain

-[4f Fluid Subdomains
=P Boundary Conditions
------ 'Eﬁ Inlet Velocity 1

- Eﬁ Static Pressure 1

P Ideal Walll

E
Figure 2.21a) Inserting global goals

G Gl
Insert Global Goals...

Insert Point Goals...

Figﬁre 2.2_1_c) Inserting point goals

Add point

- Me;l Insert Global Goals...

xvz ¥ [mj ¥ [m 7 [m]
0.2 0.02 0
0.4 0.02 0
0.6 0.02 0
0.8 0.02 0

Figure 2.21¢) Coordinates for point goals
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Figure 2.21b) Selection of friction force

%, Point Goals

v X

@ |

Figure 2.21d) Selecting point coordinates




EI F Goals

Flgure 2.21f) Renaming the point goals
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GG Friction Force (X) 1

PG Velocity (X) atx = 0.2 m
PG Velocity (X) atx =04 m
PG Velocity (X) atx = 0.6 m

. PG Velocity (X) atx=08 m

%ﬂiﬁjﬁ%

;E Eﬁ Z ey | |Reyno|dsnumberatx=0.?_m ||DimensionImLMA

1PG Velncity [4) at » = 0.2 m}*0.2/1.516E5
Figure 2.21g) Entering an equation goal

Select Tools>>Flow Simulation>>Calculation Control Options from the menu. Select the

Refinement tab. Set the Value to level =

2 for Global Domain. Select Goal Convergence and

Iterations as Refinement strategy. Click on - in the Value column for Goals and check all the
boxes in the Table. Select the Finishing tab and uncheck the Travels box under Finish
Conditions. Set the Refinements Criteria to 2.

G. Running the Calculations

22. Select Tools>>Flow Simulation>>Solve>>Run from the SOLIDWORKS menu to start the

calculations. Click on the Run button in the Run window. Click on the goals P button in the

Solver window to see the List of Goals.

Tools | Simulation Window ﬁ' D - E? - ﬁ - g © Ef) * F

F Y

it

o

AMNSYS 2020 R1

Flow Simulation

Asset Publisher...

Defeature...

T Export To AEC...

Figurg 2.22a) Starting calculations
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Run ? >

Startup
Fun
| Megh Take previous results

] Solve Cloze
(®) Mew calculation Help

Continue calculation

Figure 2.22b) Run window

@ Solver: Flat Plate Boundary Layer Study [Default] (Flat Plate Boundary Layer Study 2021.5LDPRT)

File Calculation View Inset Window Help

N ,s 0| BOF e | @

-

O nic Leg
Parameter Value Event lteration Time
Status Solver is finished. | | Mesh generation started 0 17:28:18
Total cells 119,997 Mesh generation normally finished 0 17:28:19
Fluid cells 119,997 Preparing data for calculation 0 17:28:19
Fluid cells contacting solids 3,269 Calculation started 0 17:28:20
lterations 200 Refinernent 11 17:29:06
Last iteration finished 17:29:54 Refinement 159 17:29:28
CPU time per last iteration 00:00:01 Calculation has converged since the following cr... 200 17:29:54
Travels 2.39896 Goals are converged 200
Iterations per 1 travel 91 Calculation finished 200 17:29:56
Cpu time 0:1:35
Calculation time left 0:0:0
Run at 1IMATSS0ONS
MNurnber of cores 12
Name Current Value Progress Criterion Averaged Value
GG Friction Force (X) 1 0, 4 4.46 0 0146845
PG Velocity (X) atx = 0.2 m 5.06907 m/s 0.00204776 0 5.06895 m/s
PG Velocity (X) atx = 0.4 m 5.09338 m/s 0.00282156 0 3.09359 m/s
PG Velocity (X) atx = 0.6 m 511603 m/'s 0.00341293 n  5.11623 m/s
PG Velocity (X) atx = 0.8 m 513341 m/s 0.00383436 n  5.13342 m/s
Reynolds numberatx = 0.2 m 66874.2 27.0154 66872.8
Reynolds number atx = 0.4 m 134443 74,4474 134448
Reynolds numberatx = 0.6 m 202481 135.079 202489
Reynolds number atx = 0.8 m 270892 202.34 270893

Figure 2.22c) Solver window
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H. Using Cut Plots to Visualize the Flow Field

38

23. Open the Results folder, right click on

R Cut Plots in the T Flow Simulation analysis tree
under Results and select Insert.... Select the Front Plane from the FeatureManager design
tree. Slide the Number of Levels slide bar to 255. Select Pressure from the Parameter drop
down menu. Click OK to exit the Cut Plot window. Figure 2.23a) shows the high-pressure region
close to the leading edge of the flat plate. Rename the cut plot to Pressure. You can get more
lighting on the cut plot by selecting Tools>>Flow Simulation>>Results>>Display>>Lighting
from the SOLIDWORKS menu. Right click on the Pressure Cut Plot in the Flow Simulation
analysis tree and select Hide.

Repeat this step but instead choose Velocity (X) from the Parameter drop down menu. Rename
the second cut plot to Velocity (X). Figures 2.23b) and 2.23c) show the velocity boundary layer
close to the wall.

. N

101325.00 10132626 101327.51

Pressure [Pa]
Figure 2.23a) Pressure distribution along the flat plate

—

-0181 1152 2484 3816 5149

Yelocity () [mnis]
Figure 2.23b) X — Component of Velocity distribution on the flat plate

Figure 2.23c) Close up view of the velocity boundary layer
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I. Using XY Plots with Templates

24. Place the file “graph 2.24¢).xIsm” on the desktop. This file and the other exercise files are
available for download at the SDC Publications website. Click on the FeatureManager design

tree. Click on the sketch x = 0.2, 0.4, 0.6, 0.8 m. Click on the & Flow Simulation analysis
tree tab. Right click XY Plot and select Insert.... Check the Velocity (X) box. Open the
Resolution portion of the XY Plot window and slide the Geometry Resolution as far as it goes
to the right. Click on the Evenly Distribute QOutput Points button and increase the number of
points to 500. Open the Options portion and check the Display boundary layer box. Select the
“Excel Workbook (*.xlIsx)” from the drop-down menu. Click Export to Excel to create the XY
Plot window. An Excel file will open with a graph of the velocity in the boundary layer at
different streamwise positions.

Double click on the graph 2.24c¢) file to open the file. Click on Enable Content if you get a
Security Warning that Macros have been disabled. If Developer is not available in the menu of
the Excel file, you will need to do the following: Select File>>Options from the menu and click
on the Customize Ribbon on the left hand side. Check the Developer box on the right hand side
under Main Tabs. Click OK to exit the Excel Options window.

Click on the Developer tab in the Excel menu for the graph 2.24c) file and select Visual Basic
on the left hand side to open the editor. Click on the plus sign next to VBAProject (XY Plot
1.xIsx) and click on the plus sign next to Microsoft Excel Objects. Right click on Sheet2 (Plot
Data) and select View Object.

Select Modulel in the Modules folder under VBAProject (graph 2.24¢).xlsm). Select
Run>>Run Macro from the menu of the MVB for Applications window. Click on the Run
button in the Macros window. Figure 2.24c) will become available in Excel showing the
streamwise velocity component u (m/s) versus wall normal coordinate y (m). Close the XY Plot
window and the graph 2.24c¢) window in Excel. Exit the XY Plot window in SOLIDWORKS
Flow Simulation and rename the inserted xy-plot in the Flow Simulation analysis tree to
Laminar Velocity Boundary Layer.
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* Annotations
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Figure 2.24a) Sketch for the XY Plot
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Figure 2.24b) Settings for the XY Plot
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Figure 2.24c) Boundary layer velocity profiles on a flat plate at different streamwise positions



CHAPTER 2. FLAT PLATE BOUNDARY LAYER

J. Comparison of Flow Simulation Results with Theory and Empirical Data

25. We now want to compare this velocity profile with the theoretical Blasius velocity profile for
laminar flow on a flat plate. First, we have to normalize the streamwise Velocity (X) component
with the free stream velocity. Secondly, we need to transform the wall normal coordinate into the
similarity coordinate for comparison with the Blasius profile. The similarity coordinate is
described by

n= ng (2.1)

where y (m) is the wall normal coordinate, U (m/s) is the free stream velocity, x (m) is the
distance from the leading edge and v (m?%/s) is the kinematic viscosity of the fluid.

Place the file “graph 2.25a)” on the desktop. Repeat step 24 to plot Figure 2.25a). Rename the
xy-plot to Comparison with Blasius Profile.

We see in figure 2.25a) that all profiles at different streamwise positions collapse on the same
Blasius curve when we use the boundary layer similarity coordinate.

1
0.8
j}"ﬁi/
7
Vi
j}
0.6 #
j ffffffffff x=0.2m
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u/u f{ fffffff x=0.4m
0.4 /f ****** x=0.6m
* 7
!f """"""""""""" x=0.8m
/ — Theory
0.2
0
n

Figure 2.25a) Velocity profiles in comparison with the theoretical Blasius profile (full line)
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The Reynolds number for the flow on a flat plate is defined as
Re, = — 2.2)

The boundary layer thickness & is defined as the distance from the wall to the location where the
velocity in the boundary layer has reached 99% of the free stream value. The theoretical
expression for the thickness of the laminar boundary layer is given by

_ 491x

= Tres (2.3)
, and the thickness of the turbulent boundary layer
0.16
5= rlji (2.4)

From the data of figure 2.24¢) we can see that the thickness of the laminar boundary layer is close
to 3.80 mm at Re, = 66,874 corresponding to x = 0.2 m. The free stream velocity at x = 0.2 m is
U= 5.069 m/s, see figure 2.22¢) for list of goals in solver window, and 99% of this value is Us =
5.018 m/s. The boundary layer thickness § = 3.8 mm from Flow Simulation was found by
finding the y position corresponding to the Ug velocity. This value for § at x = 0.2 m and
corresponding values further downstream at different x locations are available in the Plot Data for
Figure 2.25a). The different values of the boundary layer thickness can be compared with values
obtained using equation (2.3). In Table 2.1 are comparisons shown between boundary layer
thickness from Flow Simulation and theory corresponding to the four different Reynolds numbers
shown in figure 2.24c). The Reynolds number varies between Re, = 66,874 at x = 0.2 m and

Re, =270,894 at x = 0.8 m.

x (m) | & (mm) & (mm) | Percent (%) Us U m? Re,
Simulation | Theory | Difference (m/s) v (T)

0.2 3.795 3.797 0.1 5.01838 | 5.06907 | 0.00001516 | 66,874

0.4 5.339 5.356 0.3 5.04443 | 5.09538 | 0.00001516 | 134,443

0.6 6.496 6.547 0.8 5.06487 | 5.11603 | 0.00001516 | 202,481

0.8 7.451 7.547 1.3 5.08208 | 5.13341 | 0.00001516 | 270,892

Table 2.1 Comparison between Flow Simulation and theory for laminar boundary layer thickness

Place the file “graph 2.25b)” on the desktop. Repeat step 24 to plot Figure 2.25b). Rename the
xy-plot to Boundary Layer Thickness.

0.1
10(1)00 100000 100(l)OOO

s/x | Flow Simulation

— Theory

0.01

Re x

Figure 2.25b) Comparison between Flow Simulation and theory on boundary layer thickness
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26. We now want to study how the local friction coefficient varies along the plate. It is defined as the
local wall shear stress divided by the dynamic pressure:

Cro =12 (2.5)

12
2PU

The theoretical local friction coefficient for laminar flow is given by

0.664
Crx = T Re, < 5-10° (2.6)
and for turbulent flow
Crx = % 5-105 < Re, < 107 Q2.7

Place the file “graph 2.26” on the desktop. Repeat step 24 but this time choose the sketch x =0 —
0.9 m, uncheck the box for Velocity (X) and check the box for Shear Stress. Use the file “graph
2.26” to create Figure 2.26. Rename the xy-plot to Local Friction Coefficient. Figure 2.26
shows the local friction coefficient versus the Reynolds number compared with theoretical values
for laminar boundary layer flow.

0.1
1(l)0 1000 IO(LOO 100000 IOO(JJOOO
¢, 001 Flow Simulation
\\ — Theory
0.001
Re

X

Figure 2.26 Local friction coefficient as a function of the Reynolds number

The average friction coefficient over the whole plate Cr is not a function of the surface roughness
for the laminar boundary layer but a function of the Reynolds number based on the length of the
plate Re;, see figure E3 in Exercise 8 at the end of this chapter. This friction coefficient can be
determined in Flow Simulation by using the final value of the global goal, the X-component of
the Shear Force Fy, see figure 2.22¢), and dividing it by the dynamic pressure times the area 4 in
the X-Z plane of the computational domain related to the flat plate.

_Fp 0.000146896N
f pU2A  3:1.204kg/m3-52m?/s-1m-0.004m

=0.00244 2.8)

UL 5m/s-1m
Rey, =—=—7"7""F--
v 1.516:1075m2/s

=3.3-10° (2.9
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The average friction coefficient from Flow Simulation can be compared with the theoretical value
for laminar boundary layers

Cr = 22 = 0.002312 Re, < 5-10° (2.10)

JRer,

This is a difference of 5.5 %. For turbulent boundary layers the corresponding expression is

_0.0315
- ReL1/7

Cr 5-105 < Re, < 107 (2.11)

If the boundary layer is laminar on one part of the plate and turbulent on the remaining part, the
average friction coefficient is determined by

0.0315 1 s
Cr = o7 ~ e, (0:0315Req,” - 1.328,/Re,,) (2.12)

where Re,, is the critical Reynolds number for laminar to turbulent transition.

K. Cloning of the Project

44

27. In the next step, we will clone the project. Select Tools>>Flow Simulation>>Project>>Clone

Project.... Enter the Project Name “Flat Plate Boundary Layer Study Using Water”. Select
Create New Configuration and exit the Clone Project window. Next, change the fluid to water
in order to get higher Reynolds numbers. Start by selecting Tools>>Flow Simulation>>General
Settings... from the SOLIDWORKS menu. Click on Fluids in the Navigator portion, select Air
and click on the Remove button. Select Water from the Liquids and Add it as the Project Fluid.
Change the Flow type to Laminar and Turbulent, see figure 2.27d). Click on the OK button to
close the General Settings window.

Tools | Simulation Window X ﬁ' D - @ - ﬁ - % - -
Y J@ E

SOLIDWORKS Applications 3 attern - DiSpIanyelete Repair
Relations Sketch

Apress Products » .

SOLIDWORKS CAM +

nalysis Preparation | SOLIDWORKS CAM

AMNSYS 2020 R1 » =
5 0 Ll 68 -
Floy [ MNew.. Project
o Wizard...
N Insert
5 Rebuild Gemeral Setti
BY Genera INgs...
v | Automatic Rebuild .
<o L Units..

Display All Callouts
& S @ Computational Domain...

Hl Global Mesh...
™8 Component Contral...

4 Show Basic Mesh

”:g' Basic Mesh Color

Sele
Cﬁ? Ma

...... By Clone Project...
i | Box g Calculation Control Options...

F'iglllre 2.ifa) Cloning the project
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Clone Project @
WX
Project Name ~
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FB [Cll!ﬂil? Mew v] Xpress Products 3 S
FEI Default[1] SOLIDWORKS CAM 3 =
ANSYS 2020 R1 3 =
S |Defaurt - £
| Flow Simulation » Project
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i o nsel
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- g
Figure 2.27b) Creating a new project Figure 2.27c) Selection of general settings
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> ------ Oxygen Pre-Defined @ Aralusis b
> ------ Propane Pre-Defined Nl Wpe
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Figure 2.27d) Selection of fluid and flow type
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28. Select Tools>>Flow Simulation>>Computational Domain... Set the size of the computational

domain to the values shown in figure 2.28a). Click on the OK button to exit. Select Tools>>Flow
Simulation>>Global Mesh... from the SOLIDWORKS menu, select Manual Type and change
the Number of cells per X: to 400 and the Number of Cells per Y: to 200. Also, click on
Control Planes. Change the Ratio for X to -5 and the Ratio for Y to -100. Click on the green
check mark above Ratio, see Figure 2.28b). This will increase the number of cells close to the
wall where the velocity gradient is high. Select Tools>>Flow Simulation>>Calculation Control
Options... from the SOLIDWORKS menu. Change the Maximum travels value to 5 by first
checking the box for Travels under the Finishing tab and changing to Manual from the drop-
down menu. Travel is a unit characterizing the duration of the calculation. Click on the OK
button to exit.

Size and Conditions ~
&, |1.02m |% | Default v|
&, [012m = | Default v|
(@, [0.10001 m = @ peraur ]
&, |.1e-usm |% | Default v|
@, |0.002m |% | H symmet V|

@z |-0.002m |% | 3 symmet v|

Figure 2.28a) Setting the size of the computational domain
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Figure 2.28b) Increasing the number of cells and changing the distribution of cells
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Figure 2.28c) Calculation control options
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Figure 2.28d) Setting maximum travels

Select Tools>>Flow Simulation>>Project>>Show Basic Mesh from the SOLIDWORKS menu.
We can see in figure 2.28f) that the density of the mesh is much higher close to the flat plate at
the bottom wall as compared to the region further away from the wall.
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Figure 2.28¢) Showing the basic mesh
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Figure 2.28f) Mesh distribution in the X-Y plane

Right click the Inlet Velocity Boundary Condition in the Flow Simulation analysis tree and
select Edit Definition.... Open the Boundary Layer section and select Laminar Boundary
Layer. Click OK to exit the Boundary Condition window. Right click the Reynolds number at
x = 0.2 m goal and select Edit Definition.... Change the viscosity value in the Expression to
1.004E-6. Click on the OK button to exit. Change the other three equation goals in the same way.

Select Tools>>Flow Simulation>>Calculation Control Options from the menu. Select the
Refinement tab. Set the Value to level = 2 for Global Domain. Select Goal Convergence and

Iterations as Refinement strategy. Click on ==/ in the Value column for Goals and check all the
boxes in the Table. Select the Finishing tab and uncheck the Travels box under Finish
Conditions. Set the Refinements Criteria to 2.

Select Tools>>Flow Simulation>>Solve>>Run to start calculations. Click on the Run button in
the Run window.

Boundary Layer
() Turbulent

i@ Laminar
Figure 2.29a) Selecting a laminar boundary layer

?5'.' i Z "y | |Heyno|dsnumberatx:'l].2m Dimensionless LMA

Ewpression
{PG Welocity [ at » = 0.2 m}*0.2/1.004E §
Figure 2.29b) Modifying the equation goals
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Figure 2.29c) Creation of mesh and starting a new calculation

@ Solver: Flat Plate Boundary Layer Study Using Water [Default(1]] (Flat Plate Boundary Layer Study 2021,5LDPRT)

File Calculation View Insert Window Help

BN s 9| EQF e 0

i QB Log
Parameter Value Event lteration Time
Status Solver is finished. | | Mesh generation started 0 12:40:25
Total cells 157,148 Mesh generation normally finished 0 12:40:26
Fluid cells 157,148 Preparing data for calculation 0 12:40:26
Fluid cells contacting solids 4,620 Calculation started 0 12:40:28
[terations n Refinement 176 12:42:535
Last iteration finished 12:45:19 Refinement 270 12:44:23
CPU time per last iteration 00:00:01 Calculation has converged since the following cr... 311 12:45:19
Travels 34357 Goals are converged an
lterations per 1 travel 99 Calculation finished n 12:45:21
Cpu time 0:4:53
Calculation time left 0:0:0
Run at TIMATS50M3
Murnber of cores 12
Mame Current Value Progress Criterion Averaged Value
GG Friction Force 0.148521 N
PG Velocity (X) atx = 0.2 m 5.0238 m/'s [ EchievediT=23 0.00080033 n 5.02373 m/s
PG Velacity (X) atx = 0.4 m 5.04333 m/s D Achieie (T =288 0.00137044 0 5.04312 m/s
PG Velocity (X) atx = 0.6 m 5.06038 m/s D ECRErE T =260 0.00157720 0 5.06031 m/s
PG Velocity (X) atx = 0.8 m 5.07708 m/s D ECRErE T =20 0.00168775n  5.07671 m/s
Reynolds numberatx = 02m  1.00076e+06 DRt =| 159428 1.00074e+06
Reynolds numberatx = 0.4m  2.00929e+06 [ Achieved (IT= 248] | 545991 2.00921e+06
Reynolds numberatx = 0.6m  3.02413e+06 D ECRiEreaiTo2e0 942.605 3.02409¢+06
Reynolds number atx = 0.8m  4.04548e+06 [ Achieved (IT=270) | 1344.82 4.04519e+06 ;

Figure 2.29d) Solver window and goals table for calculations of turbulent boundary layer
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30. Place the file “graph 2.30a)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,

0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Velocity
Boundary Layer. An Excel file will open with a graph of the streamwise velocity component
versus the wall normal coordinate, see figure 2.30a). We see that the boundary layer thickness is
much higher than the corresponding laminar flow case. This is related to higher Reynolds number
at the same streamwise positions as in the laminar case. The higher Reynolds numbers are due to
the selection of water as the fluid instead of air that has a much higher value of kinematic
viscosity than water.

********** x=0.2m
fffffff x=0.4m

> 4 rrrrrrrrrrrrrrrryp T x=0.6m
""""""""""""" x=0.8m

1

0

0 0.005 0.01 0.015 0.02
y(m)

Figure 2.30a) Comparison of turbulent boundary layers at Re,, = 10® — 4.04 - 10°

As an example, the turbulent boundary layer thickness from figure 2.30a) is 3.16 mm at x = 0.2 m
which can be compared with a value of 4.45 mm from equation (2.4), see table 2.2.

O (mm) O (mm) %
x (m) Simulation | Empirical | Difference | Us(m/s) | U (m/s) | v(m?s) Re,
0.2 3.17 4.45 29 4974 5.0238 1.004E-06 | 1,000,787
0.4 6.00 8.05 25 4.993 5.0433 1.004E-06 | 2,009,044
0.6 8.75 11.39 23 5.010 5.0604 | 1.004E-06 | 3,023,958
0.8 11.32 14.57 22 5.026 5.0771 1.004E-06 | 4,045,355

Table 2.2 Flow Simulation and empirical results for turbulent boundary layer thickness

Place the file “graph 2.30b)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Boundary
Layer Thickness. An Excel file will open with a graph of the boundary layer thickness versus the
Reynolds number, see figure 2.30b).
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100(LOOO 16000000

5/x 7777777777 Flow Simulation

——— Empirical Data

0.01

Figure 2.30b) Boundary layer thickness for turbulent boundary layers at Re,, = 10° — 4.04 - 10°

31. Place the file “graph 2.31” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Comparison with One-
Sixth Power Law. An Excel file will open with Figure 2.31. In figure 2.31 we compare the
results from Flow Simulation with the turbulent profile for n = 6. The power —law turbulent
profiles suggested by Prandtl are given by

=@ :
1
; o :Zf"i;;if‘
0.6
,,,,,,,,,, <=0.2m
(777 R 8 N A e =04 m
(9 A S S S S S S A S N <=0.6m
7777777777777777777777777 x=0.8m
n=6
0.2
0
0 0.2 0.4 L | |

y/o

Figure 2.31 Velocity profiles compared with 1/6 power law for turbulent profile
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32. Place the file “graph 2.32” on the desktop. Repeat step 24 and choose the sketch x =0 — 0.9 m,

uncheck the box for Velocity (X) and check the box for Shear Stress. Rename the xy-plot to
Local Friction Coefficient for Laminar and Turbulent Boundary Layer. An Excel file will
open with figure 2.32. Figure 2.32 is showing the Flow Simulation is able to capture the local
friction coefficient in the laminar region in the Reynolds number range 10,000 — 200,000. At Re
= 200,000 there is an abrupt increase in the friction coefficient caused by laminar to turbulent
transition. In the turbulent region the friction coefficient is decreasing again but the local friction
coefficient from Flow Simulation is significantly lower than empirical data.

0.1
1000 104)00 100000 100(I)OOO 10000000
0.01
Cf,x ********** Flow Simulation
— Theory
0.001
0.0001

Re

X

Figure 2.32 Flow Simulation (dashed line) and theoretical turbulent friction coefficients

The average friction coefficient over the whole plate Cr is a function of the surface roughness for
the turbulent boundary layer and also a function of the Reynolds number based on the length of
the plate Re;, see figure E3 in Exercise 8. This friction coefficient can be determined in Flow
Simulation by using the final value of the global goal, the X-component of the Shear Force Frand
dividing it by the dynamic pressure times the area 4 in the X-Z plane of the computational
domain related to the flat plate, see figure 2.28a) for the size of the computational domain.

_Fp 0.148521N _
Cr = ZpU2A  :998kg/m?-52m? /s2-1m-0.004m 0.002976 (2.14)
UL 5m/s-1m
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The variation and final values of the goal can be found in the solver window during or after
calculation by clicking on the associated flag, see figures 2.33 and 2.29d).

@ Solver: Flat Plate Boundary Layer Study Using Water [Default(1]] (Flat Plate Boundary Layer Study 2020.5LDPRT)

File Calculation View Inset Window Help

B> s| 9 |BEOE e | 0

[ O nic | Insert Gl:ualsTaI:nIe{CtlrhTJ iCEI
Figure 2.33 Current value of the global goal

For comparison with Flow Simulation results we use equation (19) with Re_,. = 200,000

_0.0315

s
= — 7
Re Y7

Ct —RieL (0.0315Re,,” — 1.328,/Re,; ) = 0.003378 (2.16)

This is a difference of 12%.
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M. Exercises

2.1 Change the number of cells per X and Y, (see figure 2.16b), for the laminar boundary layer
and plot graphs of the boundary layer thickness, displacement thickness, momentum
thickness and local friction coefficient versus Reynolds number for different combinations of
cells per X and Y. Compare with theoretical results.

2.2 Choose one Reynolds number and one value of number of cells per X for the laminar
boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per Y. Compare with theoretical results.

2.3 Choose one Reynolds number and one value of number of cells per Y for the laminar

boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per X. Compare with theoretical results.
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2.4 Import the file “Leading Edge of Flat Plate”. Study the air flow around the leading edge at 5
m/s free stream velocity and determine the laminar velocity boundary layer at different
locations on the upper side of the leading edge and compare with the Blasius solution. Also,
compare the local friction coefficient with figure 2.26. Use different values of the initial mesh
to see how it affects the results.

Figure E1. Leading edge of asymmetric= flat plate, see Fransson (2004)

2.5 Modify the geometry of the flow region used in this chapter by changing the slope of the
upper ideal wall so that it is not parallel with the lower flat plate. By doing this you get a
streamwise pressure gradient in the flow. Use air at 5 m/s and compare your laminar
boundary layer velocity profiles for both accelerating and decelerating free stream flow with
profiles without a streamwise pressure gradient.

Figure E2. Example of geometry for a decelerating outer free stream flow.

2.6 Determine the displacement thickness, momentum thickness and shape factor for the
turbulent boundary layers in figure 2.30a) and determine the percent differences as compared
with empirical data.

2.7 Change the distribution of cells using different values of the ratios in the X and Y directions,
see figure 2.28b), for the turbulent boundary layer and plot graphs of the boundary layer
thickness, displacement thickness, momentum thickness and local friction coefficient versus
Reynolds number for different combinations of ratios. Compare with theoretical results.
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2.8 Use different fluids, surface roughness, free stream velocities and length of the computational

domain to compare the average friction coefficient over the entire flat plate with figure E3.
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Figure E3. Average friction coefficient for flow over smooth and rough flat plates, White

(1999)

100 107 108 107

Re,

55



CHAPTER 2. FLAT PLATE BOUNDARY LAYER

Notes:
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